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Copyrights and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical,
photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed
only for use with this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses
incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those
designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables
other than those designated as Epson Approved Products by Seiko Epson Corporation.

EPSON®, EPSON EXCEED YOUR VISION, EXCEED YOUR VISION and their logos are registered trademarks or trademarks of Seiko Epson
Corporation.

Microsoft®, Windows®, Windows Vista® and PowerPoint® are registered trademarks of Microsoft Corporation.
Wingdings is a registered trademark of Microsoft Corporation in the United States and other countries.

Apple®, AppleTalk®, Mac®, Macintosh®, Mac OS®, Bonjour®, ColorSync®, and TrueType® are registered trademarks of Apple Inc.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

Adobe®, Acrobat®, Adobe® RGB (1998), Adobe SansMM, Adobe SerifMM, Carta®, PostScript®, PostScript logo, and Tekton® are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Monotype is a trademark of Monotype Imaging, Inc. registered in the United States Patent and Trademark Office and may be registered in certain
jurisdictions.

Albertus, Arial, Gill Sans, Joanna and Times New Roman are trademarks of The Monotype Corporation.

Coronet is a registered trademark of Ludlow Type Foundry.

ITC AvantGarde, ITC Bookman, ITC Lubalin, ITC Mona Lisa Recut, ITC Symbol, ITC Zapf Chancery and ITC Zapf Dingbats are trademarks of
International Typeface Corporation.

Clarendon, Helvetica, New Century Schoolbook, Optima, Palatino, Stemple Garamond, Times and Univers are trademarks of Linotype Library GmbH
and/or its subsidiaries.

Marigold and Oxford are trademarks of AlphaOmega Typography.

Antique Olive is a trademark of Marcel Olive and may be registered in certain jurisdictions.

Eurostile is trademark of Nebiolo.
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NewYork, Apple Chancery, Chicago, Geneva, Hoefler Text and Monaco are trademarks of Apple Computer, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any
and all rights in those marks.

© 2014 Seiko Epson Corporation. All rights reserved.
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Before You Begin

Notes on This Guide

Meanings of Symbols

!Warning: Warnings must be followed to
avoid serious bodily injury.

!Caution: Cautions must be followed to
avoid damage to this product or
bodily injury.

c Important: Notes contain important
information on the operation of
this product.

Note: Tips contain useful or additional
information on the operation of
this product.

Operating System Versions

In this documentation, the following abbreviations are
used.

Windows refers to Windows 8.1, 8, 7, Vista, XP.
❏ Windows 8.1 refers to Windows 8.1, Windows 8.1

Pro, and Windows 8.1 Enterprise.

❏ Windows 8 refers to Windows 8, Windows 8 Pro,
and Windows 8 Enterprise.

❏ Windows 7 refers to Windows 7 Home Basic,
Windows 7 Home Premium, Windows 7
Professional, and Windows 7 Ultimate.

❏ Windows Vista refers to Windows Vista Home
Basic Edition, Windows Vista Home Premium
Edition, Windows Vista Business Edition,
Windows Vista Enterprise Edition, and Windows
Vista Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition,
Windows XP Professional x64 Edition, and
Windows XP Professional.

❏ Windows Server 2012 refers to Windows Server
2012 Essentials Edition, Server 2012 standard
Edition.

❏ Windows Server 2008 refers to Windows Server
2008 Standard Edition and Windows Server 2008
Enterprise Edition.

❏ Windows Server 2008 x64 refers to Windows Server
2008 x64 Standard Edition, Windows Server 2008
x64 Enterprise Edition, Windows Server 2008 R2
Standard Edition, and Windows Server 2008 R2
Enterprise Edition.

❏ Windows Server 2003 refers to Windows Server
2003 Standard Edition and Windows Server 2003
Enterprise Edition.

❏ Windows Server 2003 x64 refers to Windows Server
2003 x64 Standard Edition and Windows Server
2003 x64 Enterprise Edition.

Macintosh refers to Mac OS X.
❏ Mac OS X refers to Mac OS X 10.5.8 and later

versions.

License Information

Adobe Systems holds the rights to portions of this
manual, which are used with permission.
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Features

The main features of this product are described below.

Simulation

This product supports “SWOP”, “Euroscale”, “Japan
Color2001” and other CMYK simulations, allowing you
to preview results for offset printing. RGB colors can
also be simulated using RGB profiles. The RGB
simulations available include Adobe RGB, sRGB, and
Apple RGB. The product is also capable of RGB output
close to that produced by the (standard) printer driver
supplied with the printer. The product supports the
following color correction options: “Business
Graphics”, “Epson Standard (sRGB)”, and “Line
Drawing”.

Direct Print

The supplied “PS Folder” utility lets you print files by
dragging and dropping them onto the PS Folder icon.
There is no need to launch an application.

Hard Disk

The hard disk supports the same features as the optional
hard disk unit. You can:

❏ Display pending print jobs

❏ View and restart paused print jobs

❏ View and restart saved jobs

Attached to a compatible printer with an optional
scanner for large-format multifunction printers, the
product allows the device to double as a copier and
scanner. For information on supported accessories and
hard disk and scanning features, see the manual
supplied with the printer.

Notes on Use

Observe the following precautions when using this
product:

❏ This product is for printers only and can not be used
with computers or other devices.

For the latest information on supported printers,
visit the Epson website (http://www.epson.com).

❏ The hard disk may require formatting before the
product can be used with other supported printers.
The hard disk can be formatted using the
Administrator Menu > Manage HDD option in the
device control panel.

❏ Data transferred to this product can not be copied
to computers or other devices.

❏ Data may be recoverable from this product after it
has been formatted. Epson recommends that this
product be physically destroyed prior to disposal.

Data Stored on This Product
Data stored on this product can not be copied to a
computer. Be sure that the original data for print jobs
stored on this device have been saved to a computer.
Data may be deleted from this device as a result of:

❏ Static electricity or electrical noise

❏ Operator error

❏ Malfunction or repairs

❏ Natural disasters and other acts of God

Even should it occur within the warranty period, Epson
will not be held liable for loss or recovery of data stored
on this device as a result of any cause, including but not
limited to those listed above.
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Introducing the Supplied Software

Contents of the Software Disc

The supplied software disc contains the following software. Install as required.

Software name

Epson Driver and Utilities The following software is installed.

Printer Driver
The PS printer driver is required when using this device.

The PS printer driver is installed if installation is performed during product setup.

U “How the PS Driver Differs from the Standard Printer Driver” on page 12

EPSON LFP Remote Panel 2
This application is used for custom paper settings. See online help for details.

PS Folder This application lets you print files in supported formats (PS, EPS, PDF, TIFF, JPEG, and
CALS-G4) by dragging and dropping them onto the PS Folder icon, eliminating the need
to open files in another application.

U “PS Folder” on page 32
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Setting up the
Software

Windows

When installing this software, log in to an account with
administrator privileges.

Installing the PS Driver

Follow the steps below to install the PS driver and
EPSON LFP Remote Panel 2.

Note:
❏ Exit any anti-virus software before running the

installer.

❏ For information on your network setup, contact the
network administrator.

❏ If the computer is part of a network, configure the
printer so it visible on the network. Adjust network
settings with reference to the printer manual.

A Confirm that the printer is off.

B Start Windows and insert the supplied software
disc.

(1) In the AutoPlay dialog, confirm that the
publisher is SEIKO EPSON and click to
proceed.

(2) Click Yes or Continue in the User Account
Control dialog.

C When the license agreement is displayed, read
the agreement, select Accept, and click Next.

D Follow the on-screen instructions to complete
installation.

Installing PS Folder

This section describes how to install PS Folder. Install as
required.

A Start Windows and insert the supplied software
disc.

(1) In the AutoPlay dialog, confirm that the
publisher is SEIKO EPSON and click to
proceed.

(2) Click Yes or Continue in the User Account
Control dialog.

B When the license agreement is displayed, read
the agreement, select Accept and click Next.

C Follow the on-screen instructions until the
following dialog is displayed.

D After reviewing the dialog displayed in Step 3 to
ensure that PS Folder is the only option selected,
click Install.

E Follow the on-screen instructions to complete
installation.
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Mac OS X

Installation and Setup

Configure the printer after installing the PS driver and
EPSON LFP Remote Panel 2.

A Confirm that the printer is off.

B Start Mac OS X and insert the supplied software
disc.

C Click Install Navi.

D When the license agreement is displayed, read
the agreement, select Accept and click Next.

E Follow the on-screen instructions to complete
installation.

F Turn the printer on.

G Select System Preferences in the Apple menu
and click Print & Scan (or Print & Fax).

H Click +.

I Select your printer and click Add.

Note:
If your printer does not appear next to Print Using,
reselect your printer and click Add.

Installing PS Folder

This section describes how to install PS Folder. Install as
required.

A Start Mac OS X and insert the supplied software
disc.
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B Scroll down to the Apps folder, which is
concealed at the bottom of the window, and open
it.

C Click PSFolder.

D Copy the zip file to the desktop and extract it.

Uninstalling PS Driver
Software

Windows

Follow the steps below to uninstall the PS driver and the
supplied software.

c Important:
❏ Log in to an account with administrator

privileges.

❏ Enter the administrator password if prompted.

A In the case of PS Folder, the first step is to
manually delete user-created folders by dragging
them into the Recycle Bin.

Proceed to the next step to delete the driver and
other software.

B Turn the product off and disconnect the interface
cable.

C Open the Control Panel and select Programs >
Uninstall a program.

D Select the software you want to uninstall and
click Uninstall/Change (or Change/Remove or
Add/Remove).
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E If you selected the printer driver, select the icon
for this product and click OK.

F Follow the on-screen instructions to complete
the process.

If a confirmation dialog is displayed, click Yes.

If you intend to reinstall the PS driver, restart the
computer.

Mac OS X

Uninstall the PS driver or software before upgrading to a
new version or reinstalling the current version.

Uninstalling the Printer Driver

Use the “Uninstaller”.

Downloading the Uninstaller
Download the “Uninstaller” from the Epson website.

http://www.epson.com/

Using the Uninstaller
Follow the instructions provided at the site from which
you downloaded the “Uninstaller”.

Uninstalling the EPSON LFP Remote
Panel 2

Drag the EPSON Remote Panel 2 folder from
Applications into the Trash.

Uninstalling the PS Folder

Manually delete user-created folders by dragging them
into the Trash.
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PS Driver Options

How the PS Driver Differs from the Standard Printer
Driver

Before describing the PS driver supplied with this product, this manual will explore the differences between it and the
standard driver supplied with the printer. A separate description of the features unique to the PS driver is given for
each operating system. For information on the standard driver supplied with the printer, see online help.

U “Windows” on page 12

U “Mac OS X” on page 21

Windows

Using the dialog for the PS driver supplied with this product as a guide, this section explores the differences between it
and the standard driver supplied with the printer and describes the features unique to the PS printer driver.
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The Printer Settings Tab

Except when PostScript Color Transformation is selected in the dialog displayed when the Speed and Progress
button is clicked in the Utility tab, the PS and standard printer driver dialogs are distinguished only by the Edge
Smoothing option.

A

F

B

E

C

G

D

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Select Target Not available

B Color Mode Not shown, but can be adjusted by clicking Settings
button to display Color Controls dialog.

C Not available RGB Source

D Not available CMYK Simulation

E Edge Smoothing Dot Correction

F Print Preview Not available

G Layout Manager Not available

Features Unique to the PS Printer Driver
Asterisks (“*”) indicate factory default settings.
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Item Option Description

C RGB Source Choose the simulated RGB color definition when printing RGB data. This option is not available
when black is selected.

sRGB The color standard for most monitors.

Adobe RGB (1998) * A color standard defined by Adobe.

Apple RGB The color standard for Apple monitors.

ColorMatch RGB The color standard for Radius PressView monitors.

Off No simulation.
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Item Option Description

D CMYK Simulation Choose the simulated CMYK color definition for output that reproduces the colors of the CMYK
inks used in offset printing. This option is not available when black is selected.

SWOP v2 A standard used in the US publishing industry for color
printing on coated paper.

US Web Uncoated v2 A standard used in the US publishing industry for color
printing on wood free paper.

US Sheetfed Coated v2 A standard used in the US publishing industry for color
printing on coated paper.

US Sheetfed Uncoatedv2 A standard used in the US publishing industry for color
printing on wood free paper.

Coated GRACoL 2006 An US color standard for sheet-fed offset printing on Grade 1
paper.

SWOP Grade 3 Paper A standard used in the US publishing industry for color
printing on Grade 3 paper.

SWOP Grade 5 Paper A standard used in the US publishing industry for color
printing on Grade 5 paper.

Coated FOGRA27 An ISO color standard for offset printing on coated paper.

Web Coated FOGRA28 An ISO color standard for offset printing on web-coated paper.

Uncoated FOGRA29 An ISO color standard for offset printing on wood free paper.

Coated FOGRA39 An ISO color standard for offset printing on offset glossy or
matte-coated paper.

Euroscale Coated v2 * A European color standard for offset printing on coated paper.

Euroscale Uncoated v2 A European color standard for offset printing on wood free
paper.

JapanWebCoated (Ad) A color standard developed by the Japan Magazine Publishers
Association (JMPA).

JapanColor2001Coated A Japanese color standard, developed principally by the ISO/
TC130 National Committee, for printing on coated paper.

JapanColor2001Uncoated A Japanese color standard, developed principally by the ISO/
TC130 National Committee, for printing on wood free paper.

JapanColor2002Newspape A Japanese color standard for newsprint, developed
principally by the ISO/TC130 National Committee.

JapanColor2003WebCoate Version 2 of a color standard developed by the Japan
Magazine Publishers Association (JMPA).

EPSON_TOYO A color standard developed by Epson and adapted to the
unique colors of Toyo inks.

EPSON_DIC A color standard developed by Epson and adapted to the
unique colors of DIC inks.

Off No simulation.
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Item Option Description

E Dot Correction This option may or may not be displayed, depending on the selected Media Type.

Select it to improve the fidelity of line reproduction and reduce broken or deformed lines in
output from CAD programs and the like.

The Color Controls Dialog

This section describes the differences in the Color Controls dialog, which is displayed by clicking the Settings button
in the Printer Settings tab. Except when PostScript Color Transformation is selected in the dialog displayed when
the Speed and Progress button is clicked in the Utility tab, the PS and standard printer driver dialogs are identical.

A

B

C

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Mode Not available

B Not available Rendering Intent

C Not available Black Point Compensation

Features Unique to the PS Printer Driver
Asterisks (“*”) indicate factory default settings.
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Item Option Description

B Rendering Intent Choose from the following four color-space conversion options (rendering intents) for
CMYK and RGB simulations.

Absolute Absolute color coordinates are used to adapt the colors in the
original data to the color space used in printing. No color
correction is applied to the white point (color temperature) in
the original data or printed output. Choose this option for logo
colors and other jobs where accurate color reproduction is
required.

Relative The color coordinates and white point (color temperature) of
the output color space are matched to those of the color space
used in the original data. This method is frequently used for
color matching.

Perceptual * Colors are converted for a natural-looking match. Choose this
option for photographs.

Saturation Greater weight is given to the vividness of colors than to the
accuracy with which they are reproduced. Choose this option
for business graphics, including graphs and figures, in which
bright colors are preferred.

C Black Point
Compensation

Select this option if you notice loss of detail in shadows when converting from a color
space with a wide gamut to one with a narrow gamut.

This option is off by default.
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The Layout Tab

A

B

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Folded Double-Side Not available

B Poster Not available

The Print Layout Dialog

This section describes the differences in the Print Layout dialog, which is displayed by clicking the Page Layout >
Settings button in the Layout tab.

A
B
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Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Page Order Not available

B Print page frames Not available

The Advanced Tab

A

B

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Banner Not available

B Other Settings Not available
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The Hard Disk Unit Settings Dialog

This section describes the differences in the Hard Disk Unit Settings dialog, which is displayed by clicking the
Settings button in the Advanced tab.

A

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Print after Transmission Completed Caching to HDD

Features Unique to the PS Printer Driver

Item Option Description

A Caching to HDD This item should not be selected in normal circumstances. Select this option only if the
print head stops frequently during printing while the unit is processing data.

The Speed and Progress Dialog

This section describes the differences in the Speed and Progress dialog, which is displayed by clicking the Speed and
Progress button in the Utility tab.

A
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Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Not available PostScript Color Transformation

This option is on by default.

High Speed Copies Not available

Show Progress Meter

Disable EPSON Status Monitor 3

Check media type before printing

Acquire printer information automatically

Process print data by printer

Always spool RAW datatype

Page Rendering Mode

Coarse Rendering

Print as Bitmap

Allow Applications to Perform ICM Color Matching

Change Standard Resolution

Optimize Enlargement

Features Unique to the PS Printer Driver

Item Option Description

A PostScript Color
Transformation

Select this option to process colors using the target CMYK or RGB profile for PostScript
color conversion. If this option is not selected, the unit will process colors in the same way
as the standard driver supplied with the printer, and different options will be listed in the
Color Controls dialog, which is displayed by clicking the Settings button in the Printer
Settings tab.

Mac OS X

Using the dialog for the PS driver supplied with this product as a guide, this section explores the differences between it
and the standard driver supplied with the printer and describes the features unique to the PS printer driver.
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The Printer Settings Dialog

With the exception of Edge Smoothing, the dialog displayed when Off is selected for PostScript Color
Transformation in the driver options dialog is identical to that displayed by the standard driver supplied with the
printer.

A

B

D

E

C

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Select Target Not available

B Color Mode Not shown, but can be adjusted by clicking Settings
button to display Color Controls dialog.

C Edge Smoothing Dot Correction

D Not available RGB Source

E Not available CMYK Simulation

Features Unique to the PS Printer Driver
Asterisks (“*”) indicate factory default settings.
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Item Option Description

C Dot Correction This option may or may not be displayed, depending on the selected Media Type.

Select it to improve the fidelity of line reproduction and reduce broken or deformed lines in
output from CAD programs and the like.

D RGB Source Choose the simulated RGB color definition when printing RGB data. This option is not available
when black is selected.

sRGB The color standard for most monitors.

Adobe RGB (1998) * A color standard defined by Adobe.

Apple RGB The color standard for Apple monitors.

ColorMatch RGB The color standard for Radius PressView monitors.

Off No simulation.
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Item Option Description

E CMYK Simulation Choose the simulated CMYK color definition for output that reproduces the colors of the CMYK
inks used in offset printing. This option is not available when black is selected.

SWOP v2 A standard used in the US publishing industry for color
printing on coated paper.

US Web Uncoated v2 A standard used in the US publishing industry for color
printing on wood free paper.

US Sheetfed Coated v2 A standard used in the US publishing industry for color
printing on coated paper.

US Sheetfed Uncoatedv2 A standard used in the US publishing industry for color
printing on wood free paper.

Coated GRACoL 2006 An US color standard for sheet-fed offset printing on Grade 1
paper.

SWOP Grade 3 Paper A standard used in the US publishing industry for color
printing on Grade 3 paper.

SWOP Grade 5 Paper A standard used in the US publishing industry for color
printing on Grade 5 paper.

Coated FOGRA27 An ISO color standard for offset printing on coated paper.

Web Coated FOGRA28 An ISO color standard for offset printing on web-coated paper.

Uncoated FOGRA29 An ISO color standard for offset printing on wood free paper.

Coated FOGRA39 An ISO color standard for offset printing on offset glossy or
matte-coated paper.

Euroscale Coated v2 * A European color standard for offset printing on coated paper.

Euroscale Uncoated v2 A European color standard for offset printing on wood free
paper.

JapanWebCoated (Ad) A color standard developed by the Japan Magazine Publishers
Association (JMPA).

JapanColor2001Coated A Japanese color standard, developed principally by the ISO/
TC130 National Committee, for printing on coated paper.

JapanColor2001Uncoated A Japanese color standard, developed principally by the ISO/
TC130 National Committee, for printing on wood free paper.

JapanColor2002Newspape A Japanese color standard for newsprint, developed
principally by the ISO/TC130 National Committee.

JapanColor2003WebCoate Version 2 of a color standard developed by the Japan
Magazine Publishers Association (JMPA).

EPSON_TOYO A color standard developed by Epson and adapted to the
unique colors of Toyo inks.

EPSON_DIC A color standard developed by Epson and adapted to the
unique colors of DIC inks.

Off No simulation.
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The Color Controls Dialog

This section describes the differences in the Color Controls dialog, which is displayed by clicking the Settings button
in the Printer Settings dialog. Note that the dialog displayed when Off is selected for PostScript Color
Transformation in the driver options dialog is identical to that displayed by the standard driver supplied with the
printer.

A

B

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Not available Rendering Intent

B Not available Black Point Compensation

Features Unique to the PS Printer Driver
Asterisks (“*”) indicate factory default settings.
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Item Option Description

A Rendering Intent Choose from the following four color-space conversion options (rendering intents) for
CMYK and RGB simulations.

Absolute Absolute color coordinates are used to adapt the colors in
the original data to the color space used in printing. No
color correction is applied to the white point (color
temperature) in the original data or printed output.
Choose this option for logo colors and other jobs where
accurate color reproduction is required.

Relative The color coordinates and white point (color temperature)
of the output color space are matched to those of the color
space used in the original data. This method is frequently
used for color matching.

Perceptual * Colors are converted for a natural-looking match. Choose
this option for photographs.

Saturation Greater weight is given to the vividness of colors than to
the accuracy with which they are reproduced. Choose this
option for business graphics, including graphs and figures,
in which bright colors are preferred.

B Black Point
Compensation

Select this option if you notice loss of detail in shadows when converting from a color
space with a wide gamut to one with a narrow gamut.

This option is off by default.
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The Page Layout Settings Dialog

A

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Mirror Image Not listed, but available in the Layout dialog.
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The Hard Disk Unit Settings Dialog

This section describes the differences in the Hard Disk Unit Settings dialog, which is displayed by clicking the
Settings button in the Advanced dialog.

A

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Print after Transmission Completed Caching to HDD

Features Unique to the PS Printer Driver

Item Option Description

A Caching to HDD This item should not be selected in normal circumstances. Select this option only if the
print head stops frequently during printing while the unit is processing data.

This option is off by default.
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The Driver Options Dialog

This section describes the differences in the driver options dialog, which is displayed by selecting System Preferences
in the Apple menu, clicking Print & Scan, and then clicking the Options & Supplies… button.

A

Differences Between the Two Driver Dialogs

Item Standard driver supplied with printer PS driver supplied with this product

A Not available PostScript Color Transformation

This option is on by default.

Features Unique to the PS Printer Driver

Item Option Description

A PostScript Color
Transformation

Select On to process colors using the target CMYK or RGB profile for PostScript color
conversion. If Off is selected, the unit will process colors in the same way as the standard
driver supplied with the printer, and different options will be listed in the Color Controls
dialog, which is displayed by clicking the Settings button in the Printer Settings dialog.
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Using the Supplied
Software

EPSON LFP Remote Panel
2

This chapter describes features in the version of EPSON
LFP Remote Panel 2 supplied on the software disc
bundled with this product that are available only when
this product is connected. See online help for
information on other features.

Storing and Using Custom Paper 
Sizes

When this product is connected to the printer, you can
store custom paper sizes that include printer profiles
from EPSON LFP Remote Panel 2. This section
describes how to store and use custom paper sizes.

Launching EPSON LFP Remote Panel
2

Windows

A Open the Utility tab in the Print Setup dialog for
your PS driver.

B Click EPSON LFP Remote Panel 2.

Mac OS X Versions 10.6.x or later

A Select System Preferences in the Apple menu
and click Print & Scan (or Print & Fax).

B Select your printer and click Options & Supplies
> Utility > Open Printer Utility.

Mac OS X Version 10.5.8

A Select System Preferences in the Apple menu
and click Print & Fax.

B Select your printer and click Open Print Queue
> Utility.

Saving Custom Paper Sizes

Although the description in this section is illustrated
with Windows dialogs, the procedure for Mac OS X is
similar.

A Click Custom Paper Setup.

B Select #X Unregistered for Custom Name.

C For Reference Media Type, select the media type
used when the printer profile was created.

D Adjust settings as required.
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E Click the More Settings 1 tab, select a profile, and
click Save.

F Enter a paper name in the Save dialog and click
OK.

G Confirm that the new custom paper name is
displayed in the Custom Paper Setup dialog and
click Activate.

After clicking Activate, exit the software.

Note:
Custom paper settings can also be activated from
the printer control panel. For details, see the
manual supplied with the printer.

H Check custom paper settings.

Use the PS Status Sheet and Print Paper List
options in the printer control panel to confirm
that the new settings have been saved. For
information on printing the status sheet and
paper list, see the manual supplied with the
printer.

Note:
Note that because custom paper settings may be changed
if multiple users have access to the product, it is a good
idea to provide a detailed description of each option (and
file copies of the status sheet and paper list) when creating
custom paper settings.

Print Settings

Configure the PS printer driver as follows when printing
using custom paper settings:

❏ Confirm that the PostScript Color
Transformation option is checked or that On is
selected for PostScript Color Transformation.

U “The Speed and Progress Dialog” on page 20

U “The Driver Options Dialog” on page 29

❏ Confirm that the Media Type matches the
Reference Media Type selected when the custom
paper settings were created.

Note:
If the printer supports multiple rolls, confirm that the
desired roll is selected for Source.

Deleting Custom Paper Settings

Custom paper settings can be deleted using the Reset PS
Settings option in the printer control panel. Settings can
not be deleted individually.
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PS Folder

This section describes how to use the PS Folder
application included on the software disc supplied with
this product.

PS Folder lets you print files in supported formats by
dragging and dropping them onto the PS Folder icon,
eliminating the need to open files in another
application. See the following sections for installation
instructions.

Windows U “Installing PS Folder” on page 8

Mac OS X U “Installing PS Folder” on page 9

Supported File Types

File type Description

PS PostScript files (ASCII only)

EPS Encapsulated PostScript files (ASCII
only; binary not supported)

If you are unable to print EPS files, select
Add showpage in the file options and
try again.

PDF PDF version: PDF 1.7 Extension Level 3

(Adobe Acrobat 10.0 equivalent files
with password protection are also
supported)

PDF files in versions later than 1.7
Extension Level 3 will print without
errors so long as they do not use
Extension Level functions.

TIFF Tagged Image File Format files

Baseline TIFF is supported.

One pixel is treated as equivalent to one
point.

The following types of compression are
supported: CCITT1D, Group 3 Fax,
Group 4 Fax, LZW, JPEG, and PackBits
(Run Length Encoding).

ZIP compression, TIFF (TTN2), and 1-bit,
YCbCr, multi-page, and alpha-channel
TIFFs are not supported.

File type Description

JPEG Joint Photographic Experts Group files

Baseline JPEG is supported.

One pixel is treated as equivalent to one
point.

Progressive compression and JPEG
2000 are not supported.

CALS-G4 (Type
1)

Rasterized image files in CALS Type 1
format

Using PS Folder

An icon for this application is created on the desktop at
installation. Files can be printed simply by dropping
them onto the icon.

Creating Additional Icons

You can create additional PS Folder icons for other
printers or printer settings. This section describes how
to add PS Folder icons.

Windows

A Right click on an empty area of the desktop to
display a context menu.

B Select EPSON PS Folder from the New
submenu.

Enter a name for the new PS Folder.

Mac OS X

A Double-click the EPSON_PS_Folder.zip icon on
the desktop.
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B Move the newly-extracted copy of PS Folder to
the desired location.

Printing Password-Protected PDF
Files

Printing password-protected PDF files is simple. When
you drop a password-protected PDF file onto the
application icon on the desktop, you will be prompted to
enter a password.* Enter the password and click OK to
print the file.

* Depending on PDF settings, you may not be
prompted to enter a password. If a password-entry
dialog is not displayed, enter the password using the
printer control panel. For information on using the
control panel, see the manual supplied with the
printer.

Advanced Settings

To display the main application dialog, double-click the
icon on the desktop. Click Settings or OK to open the
application properties dialog and view or adjust printer
settings and file options.

Choosing a Printer

If a printer list is not displayed even though a PS driver
supported by the application is installed on the
computer, check that the PS driver is correctly installed.
Choose a printer from the list. Under Mac OS X, the
printer list will not be displayed again after you have
selected a printer.

Printer Settings

Select the Printer Settings tab in the dialog displayed
when you click the Settings button in the printer
selection dialog (Windows) or double-click the
application icon (Mac OS X).

Adjust basic print settings for the application as a whole
or make changes to print settings for individual files.
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File Option

Select the File Option tab in the dialog displayed when
you click the Settings button in the printer selection
dialog (Windows) or double-click the application icon
(Mac OS X). Adjust settings for each file type.

PDF

Option Description

Auto rotate and
Center Page

The print job is automatically
rotated and printed in the center of
pages of the selected size. Use the
Page Size option in the Printer
Settings tab to choose the page
size. This option has no effect when
Auto is selected for Page Size.

Fit to page Fit output to the selected page size.
Use the Page Size option in the
Printer Settings tab to choose the
page size. This option has no effect
when Auto is selected for Page
Size.

Reverse page Reverse the order of pages when
printing multi-page documents.

Use Overprint
Preview

Show overprinted colors when
printing.

EPS

Option Description

Add showpage Select this option if you are unable
to print EPS files.

This option adds a “showpage”
command to EPS files. Some EPS
files may require a “showpage”
command; select this option if you
are unable to print EPS files. If the
file already contains a “showpage”
command, selecting this option will
result in a blank page being printed.

TIFF/JPEG

Option Description

Auto rotate and
Center Page

The print job is automatically
rotated and printed in the center of
pages of the selected size. Use the
Page Size option in the Printer
Settings tab to choose the page
size. This option has no effect when
Auto is selected for Page Size.

Fit to page Fit output to the selected page size.
Use the Page Size option in the
Printer Settings tab to choose the
page size. This option has no effect
when Auto is selected for Page
Size.

Mirror Print a mirror image.
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Troubleshooting

This chapter lists PostScript error messages and details the steps to take when the printer fails to print. For information
on troubleshooting non-PostScript-related issues, see the manual supplied with the printer.

Control Panel Messages

If the message shown below is displayed, refer to the solution listed and take the necessary steps.

Message What to do

Firmware Error
Firmware mismatch between PS3
Expansion Unit and printer. Refer
to manual for details.

The firmware version for this product does not match the printer firmware version.

Update the firmware for the product and printer to the latest versions.

The latest versions can be downloaded from the Epson website.
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Unable to Print

This section describes how to deal with
PostScript-related issues. For information on
troubleshooting other problems, see the manual
supplied with the printer.

Errors Occur

o Does your operating system meet PS driver
system requirements?
PS driver system requirements are listed on the
following page.

U “System Requirements” on page 38

Printer Inoperable

o Are you using the correct printer driver?
O Windows
Confirm that the PS driver is selected as the default
printer.

(1) Click Start and select Devices and Printers.

In Windows 8.1/Windows 8, right click on the bottom
left corner of the display and select Control Panel
from the menu that appears. In Windows XP, click
Start and select Settings > Printers and Faxes,

(2) Right click the icon for your PS driver.

(3) Confirm that the Set as Default Printer box is
checked. If it is not, check it.

O Mac OS X
Confirm that your printer is listed in the Printer Setup
Utility.

U “Installation and Setup” on page 9

Encrypted PDFs Not Printing

o Does your account have printing privileges?
Check your account privileges.

PS Files Not Printing

o Does the printer recognize this product?
Use the Option Setup command in the printer
control panel to check whether the printer recognizes
this product.

Print Quality Issues

Printed Font/Characters Do Not 
Match Display

o Are the fonts embedded in the PDF file?
If they are not, the fonts will be replaced as
appropriate for printing.

Letters or Images Are Ragged

o Is Speed selected for Printer Settings >
Resolution?
Select Quality or High Quality for Resolution in the
Advanced Settings for Print Quality or Mode.

Light-Colored Lines Are Broken

o Use Dot Correction.

Colors Do Not Match

o Are you comparing the output to that
produced by the standard driver supplied
with the printer?
Try disabling the PostScript Color Transformation
option in the PS driver supplied with this product.

o Does the media match the Reference Media
Type selected for custom paper settings that
include printer profiles?
Colors will not match if you do not use media selected
for Reference Media Type. Check the Reference
Media Type.

o Have custom paper settings that include a
printer profile been changed?
If this product available to multiple users, custom
settings may have been changed by another user.
Check that current settings match those listed in the
status sheet printed when the custom settings were
created.
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o Is the printer set to the Paper Number used in
the creation of custom paper settings that
include a printer profile?
If this product available to multiple users, the setting
may have been changed by another user. Use the
printer driver Acquire Info option to check the Paper
Number.

Printing Results Are Uneven

o Is the print head pausing frequently?
The print head may be pausing while the printer waits
for data during printing. Try selecting On for Caching
To HDD in the printer control panel menus.

Other Issues

PS Driver Limitations

Windows may not correctly spool the data for large
print jobs. If this occurs, select Print Directly to Printer
for Advanced Options in the printer properties dialog.

Restrictions on Installing Printer 
Fonts

❏ Do not print or perform other operations while
installing printer fonts.

❏ When installing printer fonts, select PostScript for
Administrator Menu > Printer Mode in the control
panel. We recommend that you select Auto once
installation is complete.
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Appendix

System Requirements

The system requirements for installing and using the
software for this product are listed below.

Windows

OS Windows XP/Windows XP x64

Windows Vista/Windows Vista x64

Windows 7/Windows 7 x64

Windows 8/Windows 8 x64

Windows 8.1/Windows 8.1 x64

Windows Server 2003*/Windows
Server 2003 x64*/Windows Server
2008*/Windows Server 2008 x64*/
Windows Server 2008R2 x64*/
Windows Server 2012*

CPU Core 2 Duo 3.05 GHz or better

Available memory 1 GB or more

Available hard disk
space

32 GB or more

Display resolution WXGA (1280 × 768) or higher

* EPSON PS Folder and EPSON LFP Remote Panel 2
are not supported.

Note:
Log in to an “Administrator” account (an account with
administrator privileges) when installing the software.

Mac OS X

OS Mac OS X version 10.5.8 or later

CPU Core 2 Duo 3.06 GHz or better

Memory 4 GB or more

Available hard disk
space

32 GB or more

Display resolution WXGA (1280 × 768) or higher

Samples of Built-in Fonts

PostScript Fonts
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TrueType Fonts
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Software License Terms

Open Source Software Licenses

OPEN SOURCE SOFTWARE LICENSE

1) This printer product includes open source software programs listed in Section 5) according to the license terms of
each open source software program.

2) We provide the source code of the GPL Programs, LGPL Programs (each is defined in Section 5) until five (5) years
after the discontinuation of same model of this printer product. If you desire to receive the source code above, please
see the “Contacting Epson Support” in the User’s Guide, and contact the customer support of your region. You shall
comply with the license terms of each open source software program.

3) The open source software programs are WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. See the license agreements of each open
source software program for more details, which are described on \Manual\data\OSS.pdf in the Printer Software
Disc.

4) The license terms of each open source software program are described on \Manual\data\OSS.pdf in the Printer
Software Disc.

5) The list of open source software programs which this printer product includes are as follows.

GNU GPL

This printer product includes the open source software programs which apply the GNU General Public License
Version 2 or later version (“GPL Programs”).

The list of GPL Programs:
u-boot-2011.12-axp
linux-3.2.40-axp
busybox-1.18.4
lzo-2.06
mtd-utils-1.4.4
scrub-2.4
smartmontools-5.40

GNU Lesser GPL

This printer product includes the open source software programs “libusb-1.0.8” which apply the GNU Lesser
General Public License Version 2 or later version (“Lesser GPL Programs”).

BSD License (Berkeley Software Distribution License)

This printer product includes the open source software program “busybox-1.18.4” which apply the Berkeley
Software Distribution License (“BSD Program”).

Sun RPC License

This printer product includes the open source software program “busybox-1.18.4” which apply the Sun RPC
License (“Sun RPC Program”).
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